Federation
Management Tool
User’s Guide

Sponsored by the Defense Modeling and Simulation Office
Contents

Preface

Getting Technical Support ................................................................. v
Document Conventions ..................................................................... vi

Chapter 1  Introduction to the FMT

1.1. What is the Federation Management Tool? .............................. 1-2
   1.1.1. The Management Object Model ..................................... 1-2
   1.1.2. The FMT is A Participating Federate .............................. 1-2
1.2. FMT Features ........................................................................ 1-3

Chapter 2  Installing the FMT

2.1. System Requirements ............................................................. 2-2
2.2. Installing the FMT ................................................................. 2-3
   2.2.1. Installing the FMT on Solaris ...................................... 2-3
   2.2.2. Installing the FMT in Windows NT .............................. 2-3
2.3. Installing the JDK .................................................................. 2-4
2.4. Installing and Configuring the DMSO RTI .......................... 2-5
   2.4.1. Installing the DMSO RTI ............................................ 2-5

Chapter 3  Using The FMT

3.1. Starting the FMT ................................................................. 3-2
   3.1.1. Starting the rtiexec .................................................. 3-2
   3.1.2. Starting the FMT ..................................................... 3-2
3.2. Using Online Help ............................................................... 3-4
   3.2.1. Starting Online Help ............................................... 3-4
   3.2.2. Using Online Help .................................................. 3-5
   3.2.3. Online Help Features .......................................... 3-5
Preface

This manual is written for persons who will install the Federation Management Tool (FMT) or use it. The manual assumes that you are familiar with the basic operation of your operating system and that you know how to work in your computer’s graphical window environment.

The chapters are organized as follows:

Chapter 1, *Introduction to the FMT* provides a brief introduction to the FMT and its features.

Chapter 2, *Installing the FMT* explains how to install and configure the FMT.

Chapter 3, *Using The FMT* explains how to start and stop the FMT. This chapter also explains how to use the online help system, which documents the FMT interface and describes how to use the FMT to manage a federation.

**Getting Technical Support**

For technical support, send email to: fmt_help@mak.com. To make comments or change requests, go to fmt.mak.com/fmtcomment.htm. Complete the form and submit it.
Document Conventions

This document uses the following typographic conventions:

**Monospaced Type**
- Indicates commands or values you enter.

**Monospaced Italic**
- Indicates variables that you replace with appropriate values.

[ ]
- Indicates optional arguments.

|
- Separates options in a command where only one option may be chosen at a time.

/
- Indicates a directory. Since MÅK products run on both UNIX and PC platforms, we use the / (slash) for generic discussions of pathnames. If you are running on a PC, substitute a \ (backslash) when you type pathnames.

**Bold type**
- Indicates a new term.

**Italic**
- Indicates a file name or path, or a class name.

**sansSerif**
- Indicates a parameter or argument.

> 
- Indicates a one-step procedure.

Menu→Option
- Indicates a menu choice. For example, an instruction to select the Save option from the File menu appears as:
  Choose File → Save.

ℹ
- Indicates supplemental or clarifying information.

⚠
- Indicates additional information that you must observe to ensure the success of a procedure or other task.

🚫
- Indicates a warning about potential damage to the program, computer, or yourself.

Directory names are preceded with dot and slash characters that show their position with respect to the Federation Management Tool home directory. For example, the directory `fmt/bin` appears in the text as `.bin`.
Introduction to the FMT

This chapter provides a general introduction to the Federation Management Tool (FMT). It describes the following subjects:

- What is the Federation Management Tool? on page 1-2
- The Management Object Model on page 1-2
- The FMT is A Participating Federate on page 1-2
- FMT Features on page 1-3
1.1. What is the Federation Management Tool?

The Federation Management Tool (FMT) is designed to help you manage a federation execution and participating federates. Managing a federation execution is a complex task. There can be many thousands of federates participating and you must be able to understand where each one is in time, maintain the necessary degree of synchronization, save federation status so that a simulation can be resumed at a given point, and many other tasks. The FMT is the tool you need to stay on top of your simulation.

The key to managing the many aspects of a federation is to have information about the participating federates, knowing which federates are participating, what information they are publishing, what information they are subscribing to, and so on. This information is provided by the RTI through the Management Object Model (MOM).

1.1.1. The Management Object Model

The MOM provides management information about a federation execution and allows you to control the RTI, federation, and individual federates through the use of objects and interactions. Just as a federate can subscribe to simulation data, it can subscribe to management data. This data comes directly from the RTI.

In addition to obtaining management information about a federation, the MOM provides federates with the ability to control the federation through interactions. Under this mechanism, the federates initiate control interactions that are sensed and reacted to by the RTI.

Federations can extend the MOM to provide federation-specific management functions. Any of the MOM’s objects and interactions can be subclassed, providing a federation with a solid management infrastructure to build upon. MOM-extended objects and interactions are published by individual federates as specified in the Federation object Model (FOM), rather than by the RTI.

It is beyond the scope of this manual to explain the MOM.

1.1.2. The FMT is A Participating Federate

When you run the FMT, you join a federation and the FMT is viewed by the RTI as another participating federate. However, rather than participating in the simulation itself, the FMT uses the tools provided by the MOM to monitor the federation and the other participating federates. The various windows of the FMT display the information that it captures from the RTI. The menu options let you exercise control over the RTI and the other federates.
1.2. FMT Features

Federation information you can view includes:
- Federation name
- Local time
- Federation time
- Rate at which simulation is progressing
- Current status of the federation
- Whether or not any saves have occurred.

Federate information you can view includes:
- Time since last advance
- Whether a federate is constrained or regulating
- Publication information about a federate
- Subscription information about a federate
- Total number of:
  - Objects owned
  - Objects updated
  - Objects reflected
  - Updates sent
  - Interactions sent
  - Interactions reflected
- Specific federate information about a particular object

At the federation level, you can:
- Schedule saves and restores
- Request object updates
- Advance federate time
- Initiate alert logging
- Customize the FMT display
At the federate level, you can:

- Set MOM report periods
- Turn service reporting and exception logging on and off
- Alter a federate’s subscription and publication of both objects and interactions
- Enable a federate to be time constrained and time regulated
- Enable asynchronous delivery of receive order messages
- Specify lookahead time
- Modify ownership status of an object and delete an object instance
- Cause a federate to resign from the federation
- Mimic the federate’s report of a save and of reaching a synchronization point
- Advance a federate to the next time or next event
Installing the FMT

This chapter describes system requirements and explains how to install the FMT and related software. Information covered include:

- System Requirements on page 2-2
- Installing the FMT on page 2-3
- Installing the JDK on page 2-4
- Installing and Configuring the DMSO RTI on page 2-5
2.1. System Requirements

The FMT supports the following platforms:

- Sun Solaris 2.6
- PC running Microsoft Windows NT 4.0 with Service Pack 3

To run the FMT, you must have the following software:

- Federation Management Tool software
- Java Development Kit (JDK) 1.2 (also known as Java 2.0)
- DMSO RTI 1.3v5

Running the FMT on a PC requires the following hardware:

- Pentium II class PC (233 MHz minimum recommended)
- Approximately 62 MB of disk space as follows:
  - RTI - 27 MB
  - FMT - 10 MB
  - JDK - 25 MB
- 64 MB RAM

The online-help for the FMT requires a browser that supports frames and Javascript. The recommended minimum browsers are:

- Netscape 4.0 or later
- Microsoft Internet Explorer 4.0 or later.

Note: Netscape provides a somewhat more flexible implementation of popup windows than does MS Internet Explorer.
2.2. Installing the FMT

This section describes how to install FMT software on Solaris and a PC. Later sections describe installation of the JDK and RTI.

To get the FMT software, download it from the DMSO software distribution center: http://www.dmso.mil/RTISUP/hla_soft/hla_soft.htm.

2.2.1. Installing the FMT on Solaris

The FMT is provided as a compressed tar file fmt1_0.tar.Z.

To install the FMT:
1. Copy the file to a place in your directory structure where you install 3rd party software.
2. Unzip the file:
   
   ```
   uncompress fmt1_0.tar.Z
   ```
3. Untar the file:

   ```
   tar xvf fmt1_0.tar
   ```

2.2.2. Installing the FMT in Windows NT

The FMT is provided as a self-extracting zip file (fmt1_0.exe). To install the FMT:
1. In the Windows Explorer, double-click fmt1_0.exe. The WinZip Self-Extractor dialog box opens.
2. In the Unzip To Folder field, specify the directory to which you want to unzip the FMT. The default is C:\fmt1_0.
3. Click the Unzip button. The files are extracted and expanded into their subdirectories. When the files are finished being unzipped, a message box is displayed.
4. Close the message box.
5. Click Close to close the WinZip Self-Extractor dialog box.
2.3. Installing the JDK

The FMT requires the Sun Microsystems Java Development Kit (JDK) 1.2 (also called Java 2.0). Download the JDK from Sun’s java web site (http://java.sun.com/products) and install it according to their instructions.

**Note:** Because of frequent updates to the JDK software available from Sun, the software specified under system requirements may no longer be available. We cannot guarantee that the FMT will work with later versions of Java, nor can we certify it against every release.

After you install the JDK, set your PATH environment variable to point to `..//java_install_directory/bin`. Follow any other configuration instructions included with the JDK.
2.4. Installing and Configuring the DMSO RTI

To run the FMT, you must install the DMSO RTI release 1.3v5.

An RTI (Run-Time Infrastructure) is a software library (and perhaps supporting executables) that implements the HLA Interface Specification. In HLA, applications exchange FOM data through RTI calls, which means that all HLA applications need to use an RTI.

2.4.1. Installing the DMSO RTI

You can get the DMSO RTI from DMSO’s web site (http://hla.dmso.mil). Click on Software Distribution Center, where you can register for an account, then later download the RTI software.

Consult the DMSO Release Notes to determine version information and whether or not any patches are required.

⚠️ Note: To run the DMSO RTI on Windows NT 4.0, you must have Service Pack 3 installed.

Install the RTI according to the instructions provided.

Configuring Your System to Use the DMSO RTI

To configure the environment:

> On UNIX systems, source the RTI.env file.

> On Windows systems, set environment variables and add the RTI location to your path. The RTI’s README file contains detailed instructions.

You must set the following environment variables:

```plaintext
RTI_CONFIG=%RTI_HOME%\config
RTI_HOME=path_of_RTI
RTI_MESSAGE_VERSION=4321
RTI_SAVE_PATH=%RTI_HOME%\save
```
Using The FMT

This chapter explains how to start and stop the FMT. Most of the documentation for the FMT is contained in the online help. This chapter briefly describes how to use the online help system for the FMT. Topics covered in this chapter include:

- Starting the FMT on page 3-2
- Starting the rtiexec on page 3-2
- Using Online Help on page 3-4
3.1. **Starting the FMT**

To use the FMT, you must:

1. Start the rtiexec
2. Start the FMT

3.1.1. **Starting the rtiexec**

To start the rtiexec:

1. Open a command window.
2. Change to the directory that contains the RTI executables, for example:
   ```shell
cd c:\fmt\RTI1.3v5\bin\WIN32
```
3. Run the rtiexec:
   ```shell
   rtiexec
   ```
   The command window should display a message similar to the following:
   ```shell
   rtiexec@mycomputer>
   Discovery request issued
   ```

3.1.2. **Starting the FMT**

To start the FMT:

1. Open a command window.
2. Change to the directory that contains FMT files, for example:
   ```shell
cd c:\fmt
   ```
3. Enter:
   ```shell
   fmt
   ```
The FMT Startup window opens (Figure 3-1).

![FMT Startup window]

**Figure 3-1. FMT Startup window**

4. In the Federation Name field, enter the name of the federation you want to start (or have already started, if applicable.)

5. Enter a name for the FMT. The FMT is seen by the federation execution as a federate. The FMT name is the name that the FMT is known by in the federation execution.

6. In the FED Designator field, enter the name of the FED file for the federation execution that you are starting or joining.

7. Optionally, edit FMT parameters before you join the federation execution.

8. Select either the Observer or Controller button. As an observer, you can monitor the information provided by the FMT, but you cannot change any attributes of the federation execution or federates. As a controller, you can use the FMT to make changes.

9. Click Join.
3.2. Using Online Help

The online help for FMT runs in any HTML browser that supports frames and JavaScript. Please see “System Requirements” on page 2-2 and the FMT Release Notes for dependencies on different browser versions.

3.2.1. Starting Online Help

To start online help:

> Click the Help button on the FMT Startup window, the Overview window, or the Edit Parameters window. In the Federation Monitor window or the Federate Details window, choose the window name on the Help menu.

Your default browser opens with the FMT online help displayed (Figure 3-2).

![Figure 3-2. Online help](image)
3.2.2. Using Online Help

The FMT help window has three panes as illustrated in Figure 3-2:

- Contents/Index buttons - Click a button to display the Table of Contents or Index in the frame below the buttons.
- Table of Contents/Index - Click an item in the Table of Contents to display the topic in the topic window. Click an item in the index to display a topic in the topic window, or a list of relevant topics in a popup window.
- Topic window - Provides a description of part of the FMT interface or explains how to do a task.

3.2.3. Online Help Features

The FMT online help has the following features to help you get additional information about a task or topic:

- Each topic that describes a dialog box has a link to the topic that describes the procedure for which the dialog box is used.
- Each procedure that references a dialog box has a link to that dialog box.
- Most procedures have links to related topics. Related topics lists are displayed in popup windows. The popup windows stay open until you close them. They are always on top of the main browser window.
- Important terms are linked to definitions that are displayed in popup windows. You can print the definitions from the popup windows. Like related topics windows, definition windows stay open until you close them. They are always on top of the main browser window.
Index

B
browser requirements 2-2

C
change requests v
CLASSPATH
for JDK 2-4
comments v
configuring
system for DMSO RTI 2-5
conventions
manual vi

D
DMSO RTI 2-5
configuring 2-5
installing 2-5

E
environment variable
CLASSPATH 2-4

F
features 1-3
online help 3-5
FMT
overview 1-2
starting 3-2

G
getting FMT 2-3

I
installing
DMSO RTI 2-5
UNIX 2-3
Windows NT 2-3

J
Java Development Kit 2-4
JDK 2-4

M
Management Object Model 1-2
manual
conventions vi
MOM 1-2

O
obtaining FMT 2-3
online help 3-4
features 3-5
overview
FMT 1-2
Index

R
requirements
  browser 2-2
  system 2-2
RTI 1-2
  definition of 2-5
  DMSO, installing 2-5
  installing DMSO 2-5
RTI_CONFIG environment variable
  environment variable
    for RTI 2-5
RTI_HOME environment variable 2-5
RTI_MESSAGE_VERSION environment variable 2-5
RTI_SAVE_PATH environment variable 2-5
Runtime Infrastructure 1-2

S
starting
  FMT 3-2
  online help 3-4
  rtiexec 3-2
support v
system requirements 2-2

T
technical support v

U
UNIX
  installing FMT 2-3
using
    online help 3-5

W
Windows NT
  installing FMT on 2-3